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Introduction
Organizations are increasingly integrating Mac computers into Windows or other standards-based network 
environments. But users and the IT professionals who support them can relax, because Mac integration is easy. This 
guide provides step-by-step instructions for a successful integration. For additional help, please contact your 
Authorized Apple reseller or account representative.  

Audience for this guide 
This guide is for these types of learners: 

• Users who bring a Mac into organizations that predominantly use the Microsoft Windows operating system and 
Windows Server Essentials 

• Users who replace a Windows personal computer (PC) with a Mac 

• IT professionals who support Mac users in organizations that predominantly use Windows and Windows Server 
Essentials 

What you’ll learn 
In this guide, you’ll learn how to perform the following tasks: 

• Integrate a Mac into a Windows network environment. 

• Configure a Mac to work with Active Directory. 

• Take advantage of network services, file sharing, printing, instant messaging, email, calendars, and contacts. 

• Provide security at the user, local-networking, and remote-networking levels. 

• Migrate data from a Windows PC to a Mac. 

• Back up data. 

• Run Windows programs on a Mac. 

Before you start 
To have the best learning experience with this guide, you should understand how to use a Mac, a PC, and 
computer peripherals. 
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Directory Services
By joining existing networks, Mac users can follow organizational policies for authentication and use password-
protected network resources. Adding a Mac to a network with directory services is simple because network 
account support is built into macOS. 

A directory service maps network resource names to their network addresses. Microsoft’s directory service for 
Windows network domains is called Active Directory. Windows Server Essentials Server and Windows Server use 
Active Directory to provide directory services to network users. 

Apple’s directory server implementation is called Open Directory. It enables Lightweight Directory Access Protocol 
(LDAP) directory services. 

Connecting a Mac to a directory server 
Before a Mac can use a network account, you must configure it to connect to a directory server. You connect the 
Mac to a directory server in the Users & Groups pane of System Preferences. In this section, you’ll learn how to 
connect to an Active Directory, Open Directory, or LDAP directory server. 

To connect to an Active Directory server: 

1. Get the following information from the server administrator: 

• Active Directory server domain name or IP address 

• Network administrator user name and password 

• The Mac computer ID (if required) 

2. Open System Preferences. 

3. Click Users & Groups. 

4. If the pane is locked, click the lock to unlock it. 

5. In the dialog, enter the administrator user name and password. 

6. Click Unlock. 

7. Click Login Options, then click Join. 
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8. Select a service and click the pencil button to edit settings. 

  

9. Enter the Active Directory Domain name. 

10. Enter the Computer ID. 

  

11. Click Bind. 

Bind means “connect.” 

12. Enter the network administrator user name and password. 

  

13. Click OK, then click Apply. 

To connect to a directory server after you’ve already connected to a directory server: 

1. Open System Preferences. 

2. Click Users & Groups. 

3. If the pane is locked, click the lock to make changes. 

4. In the dialog, enter the administrator account name and password. 

5. Click Unlock. 
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6. Click Login Options. 

  

7. Click Edit.  A new pane appears. 

8. Click Add (+) on the left side of the pane. 

9. In the Server field, enter the Active Directory domain name or IP address. 

  

10. Click OK. 

When macOS identifies the Active Directory server address, the dialog expands to display the Active Directory 
Settings fields. 

11. Enter the Active Directory user name and password. 

12. If you like, you can edit the ID that you want Active Directory to use for the server. 

The Client Computer ID is preset to the Mac computer name. This is the same name the Mac uses in Sharing 
preferences. You can change it to conform to the organizational naming convention for computers in the 
Active Directory domain. If you’re not sure of the name, check with the server administrator. 

  

13. Click OK. 

This creates a record for the Mac in the Active Directory domain. A green dot next to the server name means 
that the connection is working. 
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To connect to an Open Directory or LDAP server: 

1. Ask the server administrator for the following information: 

• Server name or IP address 

• Secure Sockets Layer (SSL) protocol requirements 

2. Open System Preferences. 

3. Click Users & Groups. 

4. If the pane is locked, click the lock to unlock it. 

5. In the dialog, enter the administrator user name and password. 

6. Click Unlock, then click Login Options. 

7. Click Join. If you’ve previously joined a directory server, click Login Options, then click Edit. 

8. In the dialog, click Add (+). 

  

9. Choose a server from the pop-up menu, or enter the server domain name or IP address.

  

10. Click OK. 

macOS connects to the directory server. You’ll be notified if the directory server doesn’t provide a secure 
connection via SSL. You’ll have the option to continue or cancel the connection to the server. 

You’ve bound the Mac to an LDAP server. Now you can log in to the LDAP server using your network user 
account. 

Using network accounts 
In the previous steps, you bound the Mac to a network directory server using the local Mac user account. To access 
network resources, log in using a network account. To do this, you’ll need a network account user name and 
password from the server administrator. For Active Directory accounts, the user name can be in one of three 
formats: 

• shortname 

• shortname@domain.com 

• DOMAIN\shortname 
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To log in using a network account: 

1. If you’re currently logged in to the Mac, log out by choosing Log Out from the Apple menu. 

macOS logs you out, and a login window lists the user accounts, followed by Other. 

If the Mac has one user account, it displays the login screen for that account when you log out. 

2. Click the user account name or picture. 

3. Click the left arrow button in front of the account name to access the Other login button. 

4. Enter the network account user name and password provided by the server administrator. 

5. Press Return or click the Log In (right arrow) button. 

You’re now logged in to the Mac with the account provided by the directory server. The Mac is fully integrated 
into the network. It can take advantage of user authentication and network resources provided by the 
organizational directory server. 

Summary 
In this section, you learned how to set up a Mac to connect to a directory server. You should now be able to do the 
following tasks: 

• Bind a Mac to a directory server. 

• Log in to a Mac with a network user account. 
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File Sharing
Organizations constantly share files and resources across networked computers. macOS supports many popular file 
server protocols. In this section, you’ll learn how to do the following tasks: 

• Connect a Mac to file servers. 

• Configure personal file sharing to let other network users access files on a Mac. 

Connecting to file servers 
You can connect a Mac to PCs with file sharing turned on. You can also connect a Mac to file servers that use these 
protocols: 

• Server Message Block (SMB) 

• Common Internet File System (CIFS) 

• Apple Filing Protocol (AFP) 

• Network File System (NFS) 

• Web Distributed Authoring and Versioning (WebDAV) 

• File Transfer Protocol (FTP) 

To access shared files on PCs and file servers on your network, use either of these methods: 

• Look for the computer in the Finder. 

• Enter the computer IP address directly in the “Connect to Server” dialog. 

To connect to a computer or server by browsing: 

1. Open the Finder. 

2. From the Go menu, choose “Connect to Server.” 

  

3. Click Browse. 

The Finder lists computers on your network that have Sharing turned on. 

4. Search for the computer or server name that you want to connect to. 

You may need to know the network area or workgroup where the computer is. 

5. When you locate the shared computer or server you want, select it and click Connect As. 
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6. If you want to select volumes or shared folders on the server, enter your user name and password. 

7. Select volumes or shared folders. 

8. Select “Remember this password in my keychain.” 

This adds your user name and password for the server to your keychain. The next time you connect to the 
server, you’ll gain access automatically. 

To connect directly to Windows file servers: 

1. In the Finder, choose Go > Connect to Server. 

2. Enter the IP address or the server’s fully qualified domain name. 

Use one of these formats: 

//DNSname/sharename 

//IPaddress/sharename 

DNSname is the server domain name. IPaddress is the server IP address. sharename is the name of the shared 
volume to be mounted. You don’t have to specify the SMB protocol—it’s the default. 

If you’ve recently connected to a file server, you can choose it from the Recent Servers pop-up menu: 
 

To add a computer or server to your Favorite Servers list, enter the address, then click Add (+). Then you can 
double-click the server address to connect to it. 

3. Click Connect. 

4. For Connect As, select Registered User and enter the user name and password. 

You’ve now used your Mac to access files stored on network file servers. You can also set up your Mac so other 
network users can access your files with personal file sharing. In the next section, you’ll learn how to enable 
personal file sharing on your Mac. 

Turning on personal file sharing 
To allow other network users to connect to your Mac, turn on file sharing in System Preferences. You can create a 
special sharing account on your Mac to maintain the security of your unshared files. 

To authorize users to access your shared files, give them the following information: 

• The IP or Bonjour address of your Mac 

• The user account name for the account on your Mac that has file sharing turned on 

• The user account password for the file-sharing account on your Mac 

If you want to use an account that existed before you installed macOS Sierra, you might need to reset the 
password. You can do this in Users & Groups preferences. 

Before you set up sharing, select the folders you want to share with network users and the permissions users will 
have. By default, the Mac administrator account has full read and write access, and other accounts have only read 
access. 
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To select the folders you want to share: 

1. Open System Preferences. 

2. Click Sharing. 

3. Select File Sharing in the Service list on the left. 

  

4. At the bottom of the Shared Folders list, click Add (+). 

5. Select the folder you want to share and click Add (+). 

  

Any user set up on your Mac in Users & Groups preferences can connect to your Mac over the network. A user 
with an administrator account can access everything on your Mac. 

To give specific users access to a folder: 

1. Select the folder in the Shared Folders list. 

  

2. At the bottom of the Users list, click Add (+). Then do one of the following: 

• Select a user from Users & Groups, which includes all users of your Mac. 

• Select a user from Network Users or Network Groups, which includes everyone on your network. 

• Select a person from your contacts, create a password for the person, and then click Create Account. 
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3. In the Users pane, select the user name and choose the appropriate level of access: 

• No Access—The user can’t see or copy files from the folder. This option is available only for Everyone. To 
deny access to files or a folder for other users, select the user and click Delete (–). 

• Read & Write—The user can see and copy files to and from the folder. 

• Read Only—The user can view the contents of the folder but can’t copy files to it. 

• Write Only (Drop Box)—The user can copy files to the folder but can’t view its contents. 

4. Give authorized users the following information: 

• IP or Bonjour address—You can see your Bonjour address in the Sharing pane. 

• User name and password 

5. Set the protocol that your Mac uses to share files.  

When you connect from a Mac to another computer using file sharing, macOS automatically uses SMB to 
communicate. If SMB isn’t available, macOS tries to connect using AFP. For more information, read How to 
connect with File sharing on your Mac. 

To enable personal file sharing for Windows and Mac users: 

1. Open System Preferences. 

2. Click Sharing. 

3. Select File Sharing. 

4. Click Options. 

5. Select the accounts that you want to enable to share files. 

  

6. Click Done. 

You’ve enabled personal file sharing on your Mac. Authorized network users can now access the files and 
volumes you chose to share. 
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Summary 
In this section, you learned how to share files. You should now be able to do these things: 

• Access shared files on a network via browsing and direct connection. 

• Set up folder and user permissions for personal file sharing. 

• Provide network users with a user name and password so they can access files on your Mac. 
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Email, Contacts, and Calendars
macOS supports email, contacts, and calendars using standards-based servers, including Microsoft Exchange 
Server, POP, SMTP, and more. With macOS, you can connect to shared services such as email, calendars, and global 
address lists. In this section, you’ll learn how to configure these apps: 

• Mail—To send and receive email via common server types 

• Contacts—To access shared contacts 

• Calendar—To access shared calendar services 

Managing Internet Accounts preferences 
macOS includes built-in support for the latest version of Microsoft Exchange Server, so you can use your Mac with 
the Microsoft features and apps you’re familiar with. You’ll also have your messages, meetings, and contacts in one 
place. 

Using Internet Accounts, you can quickly set up the accounts you want to use with Mail, Messages, Calendar, and 
other apps. 

  

In the Internet Accounts pane, the list on the left shows the web service accounts you provided information for 
when you did the following: 

• First configured macOS with Setup Assistant 

• Created an account in an app 

• Used Internet Accounts preferences 

The list on the right shows major service providers that you can set up in Internet Accounts preferences. 

• To view or change information about an account, select the account and click Details. 

• To remove a selected account and turn off its features, click Delete (–). 

If multiple apps use a selected account, you can stop an app from using the account by deselecting its checkbox. 

To add an account in Internet Accounts preferences: 

1. Open System Preferences. 

2. Click Internet Accounts. 
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3. If you haven't added an account yet, click the account type that you want to add. 

4. Enter your email address and password and click Sign in. 

5. If you already added an account, and it’s selected, click Add (+). 

This takes you to the main Internet Accounts pane. 

6. Click an account type, enter your account information, and follow the onscreen instructions. 

  

7. Make sure the apps you want to use with the account are selected. 

  

Connecting to an Exchange Server 
Mail and Calendar support these Exchange Server versions: 

• Office 365 

• Exchange Server 2013 

• Exchange Server 2010 

• Exchange Server 2007 

To connect a Mac to an Exchange server, obtain the server user name and password from your server 
administrator. 

If the Exchange Autodiscover service isn’t enabled on the Exchange server, obtain the fully qualified domain name 
for the organization’s Client Access Server (CAS). 

The CAS fully qualified domain name usually looks like this: exchange01.example.com. 

Mac Integration Basics 10.12 - Guide   17
© 2017 Apple Inc. All rights reserved. Apple and the Apple logo are trademarks of Apple Inc., registered in the U.S. and other countries.



After you have the required information, you can configure your Mac manually to use the Exchange Server, or 
configure it automatically by using the Exchange Autodiscover service. 

The easiest way to set up Contacts and Calendar to access Exchange is with Exchange Autodiscover. If this feature 
is enabled on the Exchange server, perform the steps listed below. 

To connect to an Exchange server with Autodiscover enabled: 

macOS uses the Autodiscover service in Exchange to get relevant account information. If it’s enabled, you can start 
using Exchange services immediately. 

1. Open System Preferences. 

2. Click Internet Accounts. 

3. Click Add (+) to add the Exchange server if it isn’t in your list of servers. 

You won’t see the plus sign until one account is created. 

4. Click Exchange in the list of services. 

5. Enter your Exchange email address and password. 

  

6. Click Sign In. 

7. Select the services you want to connect to. 

To manually configure a Mail account to connect to an Exchange server: 

If Autodiscover isn’t enabled on the Exchange server, follow the steps below to manually configure your Mail 
account. 

1. Open System Preferences. 

2. Click Internet Accounts. 

3. Click Exchange in the list of services on the right. 

4. Enter your Exchange email address and password. 

5. Click Sign In. 

6. Enter a description for the account (for example, Work or Exchange). 

7. Enter the internal and external URLs for your organization’s Exchange client-access server. 
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8. Click Continue. 

9. To set up Contacts and Calendar automatically, make sure their checkboxes are selected. 

10. Click Done. 

11. Send and receive emails from your Exchange account to confirm that you configured Mail successfully. 

To access an Exchange server from a Mac outside an organizational network, confirm the following with the server 
administrator: 

• Port 443 is open on the firewall. 

• Exchange Web Services (EWS) is enabled on the server. 

Connecting Mail to non-Windows servers 
If your organization uses a non-Windows server for email services, you can configure Mail to access it. Common 
mail-server protocols for non-Windows servers include: 

• Post Office Protocol (POP)—This protocol allows client computers to access messages on a mail server. 

• Internet Message Access Protocol (IMAP)—This protocol allows client computers to access messages on a mail 
server. 

• Simple Mail Transfer Protocol (SMTP)—This protocol allows messages to be sent from a client computer to a mail 
server. It also allows messages to be sent between mail servers. 

To configure Mail to connect to non-Windows email services: 

1. Open Mail. 

2. From the “Choose a Mail account provider” dialog, select “Other Mail Account.” 

  

3. Click Continue. 

4. Enter your Mail account full name, email address, and password. 

5. Click Sign In. 

If macOS identifies the mail-server type and successfully connects, it creates the mail account. You can now 
send and receive email. If macOS can’t identify the mail server type, you must manually configure the account. 

6. When you’re prompted to manually create the account, click Next. 

7. In the Incoming Mail Server Info pane, select the type of email account: IMAP or POP. 

8. Enter the mail server address provided by your Internet service provider (ISP) or mail server administrator. 
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9. Verify that the User Name and Password fields are correct. 

10. Click Next. 

11. If the port address and authentication type are displayed, verify that they’re correct. 

12. Click Next. 

13. In the Outgoing Mail Server Info pane, enter the outgoing mail server address and authentication information. 

14. Click Create. 

15. Send and receive emails to verify that you’ve successfully configured Mail for use with common mail server 
protocols. 

Adding accounts in Mail, Contacts, and Calendars 
In addition to configuring accounts in Internet Accounts preferences, you can configure accounts in Mail, Contacts, 
and Calendar. 

To add a new account from Mail: 

1. Choose Add Account from the Mail menu. 

  

An assistant appears and guides you through the steps to add a mail account. 

If you can’t connect to your mail server, visit Use Mail Connection Doctor. Also, verify your login information 
with your mail service or support department. 

2. To view your login information, choose Mail > Preferences. 

3. Click Accounts. 

4. Click the question mark (?) in the lower-right corner of the pane for Mail Help. 

To add a new account from Contacts: 

1. Choose Add Account from the Contacts menu. 
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An assistant appears and guides you through the steps to add a contacts account. 

2. If your organization uses CardDAV or LDAP for contact data, select Other Contacts Account. 

The Card Distributed Authoring and Versioning (CardDAV) protocol is based on an Internet standard for 
sharing contact information. 

3. Ask your server administrator for the address of the CardDAV server that hosts your CardDAV account. 

4. Ask your server administrator for the information you need to complete the fields in the LDAP pane. 

An LDAP Internet account is based on an Internet standard for finding information on an LDAP directory 
server. Depending on how your LDAP server is configured, the information you must provide may be complex. 

  

To enable or disable accounts that are available to Contacts: 

1. Choose Contacts > Preferences. 

2. Click Accounts. 

3. Select the account. 

4. Click the Add (+) or Remove (–) button. 

To add a new account from Calendar: 

Choose Add Account from the Calendar menu. An assistant guides you through the steps. 

To enable or disable accounts that are available to Calendar: 

1. Choose Calendar > Preferences. 

2. Click Accounts. 

3. Enable or disable accounts. 
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Summary 
In this section, you learned how to configure a Mac to access server-based mail, contacts, and calendar services. 
You should now be able to perform these actions: 

• Use Internet Accounts preferences to add mail, contacts, and calendar accounts. 

• Connect to an Exchange server. 

• Connect Mail to POP and IMAP servers. 

• Configure accounts directly from Mail, Contacts, and Calendar. 
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Security
At Apple, we care deeply about security and protecting the systems, apps, and data of end users and organizations. 
Mac provides a comprehensive approach to security that protects the entire platform, including the operating 
system, the services, the data on each device, and all the apps. 

macOS has a multi-layered approach to security, meaning that security features are built in from the ground up 
and integrated throughout the system. Security is designed into the hardware, software, and app ecosystem and is 
an essential consideration in data storage, retrieval, and transmission. 

macOS offers technology and strong, easy-to-use tools for Mac and network security. You can help maintain 
security by protecting your user data, Mac computers, and networks. In this section, you’ll learn about built-in 
security features and the following ways you can protect your Mac: 

• Creating strong passwords 

• Using two-factor authentication 

• Setting a firmware password 

• Locking the Mac screen 

• Creating user accounts 

• Disabling automatic login 

• Protecting start-up disk files 

• Using Gatekeeper to download safe apps 

• Providing network security 

Built-in security features 
macOS offers multilayered security technologies that help protect against viruses, malicious apps, and malware. In 
this section, you’ll learn about these automatic security features: 

• Sandboxing 

• System Integrity Protection 

• Library randomization 

• Execute disable 

Sandboxing 

Through a technique called “sandboxing,” macOS prevents hackers from harming your programs. Sandboxing 
restricts the following: 

• Actions that programs can perform on your Mac 

• Files that programs can access 

• Programs that can be launched 
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System Integrity Protection 

System Integrity Protection helps prevent potentially malicious software from modifying protected files and folders 
on a Mac. 

System Integrity Protection uses sandboxing to restrict the root account. It limits actions that the root account can 
perform on protected parts of macOS. System Integrity Protection protects apps that are preinstalled with macOS 
and these folders: 

• /System 

• /usr 

• /bin 

• /sbin 

Folders that third-party apps and installers can write to include: 

• /Applications 

• /Library 

• /usr/local 

Only processes that are signed by Apple and have entitlements to write to file systems can modify the protected 
parts of macOS. Examples of these processes include Apple software and Apple installers. 

Apps downloaded from the App Store already work with System Integrity Protection. Consider removing third-
party software that conflicts with System Integrity Protection when you upgrade to OS X El Capitan or macOS 
Sierra. 

System Integrity Protection also helps prevent software from changing your startup volume. To start up a Mac from 
a different volume, use the Startup Disk pane in System Preferences. Or, hold down the Option key while you 
restart, and select a volume from the list. 

Library Randomization 

Library Randomization keeps malicious commands from finding their targets. 

Execute Disable 

Execute Disable protects the memory in your Mac from attacks. 

Creating strong passwords 
You can create a strong password if you include these attributes: 

• At least eight characters 

• At least one uppercase and one lowercase letter 

• At least one number 

• At least one punctuation mark or symbol 
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For example, L1quid$m0ke is a good password. It’s a long, uncommon phrase with letters that are replaced by 
special characters and numbers. 

macOS features Password Assistant, which checks your password strength or generates a strong password for you. 
You can tell Password Assistant what password type and length you’d like it to create. And you can choose from 
these password types: 

• Manual—Enter a password, then Password Assistant ranks the strength of the password on a sliding scale. If the 
password is weak, Password Assistant offers tips for increasing its strength. 

• Memorable—Adjust the password Length setting. Password Assistant generates a list of memorable passwords 
containing words and some random characters; for example, “wept1]puller.” 

• Letters & Numbers—Adjust the password Length setting. Password Assistant generates a list of passwords with a 
combination of letters and numbers; for example, “tSFCF4lLh2yc.” 

• Numbers Only—Adjust the password Length setting. Password Assistant generates a list of passwords containing 
only numbers; for example, “007515850186.” 

• Random—Adjust the password Length setting. Password Assistant generates a list of passwords containing 
random characters; for example, “)RO{AFKTDc\0.” 

• Federal Information Processing Standard (FIPS)-181 compliant—Adjust the password Length setting. Password 
Assistant generates a password that is FIPS-181 compliant; for example, “cdavicourgok.” 

To use Password Assistant to create a password: 

1. Open System Preferences. 

2. Click Users & Groups. 

3. Select a user. 

4. Click Change Password. 

5. Click the Key (  ) to the right of the “New password” field. 

This opens Password Assistant. 

6. From the Type pop-up menu, choose the password type that meets your organizational security standards.

  

8. To choose the number of characters for an automatically generated password, move the Length slider to the 
left or right. 
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9. Close the Password Assistant pane. 

10. Click Change Password. 

  

Using two-factor authentication 
Two-factor authentication is an extra layer of security for your Apple ID. It’s designed to ensure that you're the only 
person who can access your account—even if someone else knows your password. 

How it works 

With two-factor authentication, your account can be accessed only on devices you trust—like your iPhone, iPad, or 
Mac. When you sign in to a new device for the first time, you’ll provide two pieces of information—your password 
and the six-digit verification code that's automatically displayed on your trusted devices. By entering the code, you 
verify that you trust the new device. For example, suppose you have an iPhone and you sign in to your account for 
the first time on a new Mac. You'll be prompted to enter your password and the verification code that 
automatically displays on your iPhone. 

Because your password alone isn’t enough to access your account, two-factor authentication improves the security 
of your Apple ID. And all the personal information you store with Apple is more secure, too. 

When you have signed in, you won’t be asked for a verification code on that device again. If you sign out 
completely, erase the device, or change your password, you'll be asked for the code. When you sign in on the web, 
you can choose to trust your browser. And you won’t be asked for a verification code the next time you sign in 
from that computer. 

Trusted devices 

A trusted device is an Apple device that you've already signed in to using two-factor authentication. It’s a device 
you can use to verify your identity. It displays a verification code from Apple when you sign in on a different device 
or browser. Trusted devices include: 

• iPhone and iPad devices using iOS 9 or later 

• Mac computers using OS X El Capitan or later 

Trusted phone numbers 

You can use a trusted phone number to receive verification codes by text or phone call. You must verify at least 
one trusted phone number to enroll in two-factor authentication. Consider verifying other phone numbers you can 
access—like a home phone, or a number used by a family member or close friend. You can use those numbers if 
you temporarily can't access your own device. 
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Verification codes 

A verification code is a temporary code that is sent to your trusted device or phone number. This happens when 
you sign in to a new device or browser with your Apple ID. You can also get a verification code from Settings on 
your trusted device. 

A verification code is different from the device passcode that you enter to unlock your iPhone, iPad, or iPod touch. 

To turn on two-factor authentication for your Apple ID: 

1. Go to the Apple () menu > System Preferences > iCloud > Account Details. 

2. Click Security. 

3. Click “Turn on Two-Factor Authentication.” 

  
What to remember when you use two-factor authentication 

Two-factor authentication significantly improves the security of your Apple ID. After you turn it on, signing in to 
your account requires two things: 

• Your password 

• Access to your trusted devices or trusted phone number 

To keep your account secure and help ensure that you never lose access, follow these guidelines: 

• Remember your Apple ID password. 

• Use a device passcode on all your devices. 

• Keep your trusted phone numbers up to date. 

• Keep your trusted devices physically secure. 

Setting a firmware password 
Setting a firmware password helps keep unauthorized start-up devices from bypassing the macOS security. You can 
set a firmware password to enable low-level hardware protection for your Mac. A firmware password helps prevent 
unauthorized users from starting up your Mac from the following devices: 

• External hard disk 

• Optical disc 

• Universal Serial Bus (USB) flash drive 

To set a firmware password: 

1. Restart your Mac and hold down Command-R to start up using the Recovery HD partition. 

2. When the macOS Utilities window appears, choose Utilities > Firmware Password Utility. 

3. Click “Turn On Firmware Password.” 

4. Enter a password in the Password and Verify fields. 
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5. Click Set Password. 

6. Click “Quit Firmware Password Utility.” 

You can test your settings by attempting to start up in single-user mode. Restart the Mac while you hold down 
the Option key. If you see a lock button with a password field, you'll know that changes made by the Firmware 
Password Utility were successful. Enter your firmware password to continue. 

To reset a firmware password: 

To reset a lost firmware password, take your Mac to an Apple Retail Store or Apple Authorized Service Provider. For 
more information, read If you lost or forgot your firmware password. 

Locking a Mac screen 
To stay logged in to your Mac while you’re away—and prevent others from using it—you can lock the screen. 
When you return to your Mac, type your login name and password to continue working. 

To require authentication to wake your Mac: 

1. Open System Preferences. 

2. Click Security & Privacy. 

3. Click General. 

4. Click the lock button. 

5. Select “Require password delay before a password is required after sleep or screen saver begins.” 

  

6. In the pop-up menu, you can adjust the length of delay before a password is required. 

  

Locking the screen doesn’t prevent a user from turning off a Mac, restarting it, and logging in to an account. If 
you think this could happen, save your work before you leave your Mac. 
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To lock your screen with fast user switching enabled: 

If your Mac has multiple users, you can turn on fast user switching. It enables more than one user to stay logged in 
at the same time. You can lock your screen quickly when fast user switching is enabled. This keeps your apps open 
and undisturbed, but it locks your Mac. 

1. Click your name at the top right of the Mac screen. 

2. Choose Login Window from the menu. 

Creating user accounts 
If you’re sharing a Mac, you should create an account for each user. Separate user accounts protect user 
information and make the Mac more secure. 

Disabling automatic login 
Automatic login means anyone can access your Mac simply by restarting it. If your Mac has multiple accounts, with 
automatic login configured for one account, it automatically logs in to that account during startup. Whether your 
Mac has multiple user accounts or just yours, you should disable automatic login if you want to keep the Mac more 
secure. If you decide to enable automatic login, make sure the Mac isn’t set up to automatically log in to an 
administrator account. 

To turn off automatic login: 

1. Open System Preferences. 

2. Click Users & Groups. 

3. Click the lock button. 

4. Enter your user name and password. 

5. Click Unlock. 

6. Click Login Options. 

7. Choose Off from the “Automatic login” pop-up menu. 

The next time you start up your Mac, the login window appears. Enter a user name and password to log in. 

Protecting start-up disk files 
FileVault full-disk encryption uses XTS-AES 128 encryption to help prevent unauthorized access to your startup disk. 
The Advanced Encryption Standard with 128-bit keys (AES-128) is U.S.-government approved. 

If you store sensitive data on your Mac, consider using FileVault. Say, for example, you lose your Mac, and it contains 
your business’s financial data. Then an unauthorized person accesses the data and hurts your business. If you had 
enabled FileVault and logged out of your account, the data would have been protected. 

When you turn on FileVault, you get a recovery key. You can use the recovery key to unlock the startup disk if you 
forget your administrator login password. 
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To ensure security, other security features are also turned on when you turn on FileVault. For example, you need a 
password to log in after your Mac does the following: 

• Wakes from sleep 

• Leaves the screen saver 

After initial startup, only users enabled in FileVault can log in. Other users need an administrator to log in first. 

Important: If you turn on FileVault and forget your login password, Apple ID, and recovery key, you won’t be able 
to log in to your account, and your files and settings will be lost. 

To set up FileVault: 

1. Open System Preferences. 

2. Click Security & Privacy. 

3. Click FileVault. 

4. Click the lock. 

5. Enter your user name and password. 

6. Click Unlock. 

6. Click Turn On FileVault. 

  

macOS presents the option to use your iCloud account to reset your password or create a recovery key. 

7. Choose “Create a recovery key and do not use my iCloud account.” 

8. Click Continue. 

A dialog appears with a recovery key you can use to unlock the disk if you forget your password. 

9. Copy the recovery key and store it in a safe place. 

Important: If you forget your password and lose the recovery key, all data on your disk will be lost. 

10. Click Continue. 

11. If your Mac has multiple user accounts, you can enable the users to decrypt files on the startup disk. As the 
administrator user on your Mac, you can prevent your Mac users from unlocking the disk. If you do this, you’ll 
need to unlock the disk. 
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12. Click Continue. 

13. Click Restart. 

After you restart your Mac, the encryption process begins. It may take a few minutes or more to encrypt your 
disk, depending on how much information you have on it. However, you can use the Mac while the disk is 
being encrypted. 

Ensuring that the apps you download are safe 
Gatekeeper protects you from inadvertently installing malicious software on your Mac when you download apps. 
The safest place to download apps for your Mac is the Mac App Store. Apple reviews each app before it’s accepted 
by the store, and if an app ever develops a problem, Apple can quickly remove it from the store. Developers can 
get a unique Developer ID from Apple and use it to digitally sign their apps. The Developer ID allows Gatekeeper to 
block apps created by malware developers and to verify that apps haven’t been tampered with. If an app was 
developed by an unknown developer—one with no Developer ID—Gatekeeper can keep your Mac safe by 
blocking the app from being installed. 

Gatekeeper gives you two security options. You can choose the safest option and download and install apps only 
from the Mac App Store. Or you can use the default option, which allows you to download apps from the Mac App 
Store as well as those signed with a Developer ID. If an app is unsigned, Gatekeeper blocks the app from being 
installed and warns you that it did not come from an identified developer. If you’re sure the app is safe, you can 
manually override Gatekeeper by Control-clicking the app and choosing to open it. 

To set the allowed app sources: 

1. Open System Preferences. 

2. Click Security & Privacy. 

3. Click General. 

4. Choose the software sources you want to allow. 

  

App Store—You can download apps only from the App Store. When you download an app from the App Store, 
macOS makes sure the app wasn’t modified after the developer shipped it. If a problem arises with an app, 
Apple removes it from the App Store. 

App Store and identified developers—You can download apps from the App Store and apps from identified 
developers. Apps from outside the App Store aren’t reviewed by Apple, but Apple identifies and registers 
certain developers. If problems occur with an app developed by a registered developer, Apple can revoke its 
authorization. When you download an app from the App Store, macOS makes sure the app wasn’t modified 
after the developer shipped it. 

In addition to certain apps, other file types might be unsafe. Scripts, web archives, and Java archives can harm your 
Mac. An alert appears when you first try to open these files. Not all files like these are dangerous, but be careful 
when you open any downloaded file. 
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To open an app that’s blocked by Gatekeeper: 

1. Hold down the Control key and click the app’s icon. 

2. Choose Open from the shortcut menu. 

You see a prompt that says, “Opening the blocked app will always allow it to run on this Mac.” 

3. Click Open. 

Providing network security 
Network security is just as important as user account and system security. The macOS firewall protects your Mac 
from unauthorized access by other systems on local networks and the Internet. The virtual private network (VPN) 
provides a secure way for your Mac to remotely access networks. 

Turning on the macOS firewall 

You can use the macOS personal firewall to block unwanted incoming connections to your Mac. A firewall protects 
the services on your Mac from other computers on the network or Internet. Services turned on in Sharing 
preferences appear in the list of services that other computers can connect to. To prevent incoming connections to 
these services, you must turn off the services in Sharing preferences. 

To turn on the macOS firewall: 

1. Open System Preferences. 

2. Click Security & Privacy. 

3. Click Firewall. 

4. Click the lock to unlock the Firewall pane. 

5. Type your administrator name and password. 

6. Click “Turn On Firewall” to enable the firewall. 

  

7. Click the lock to prevent further changes. 
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To configure advanced firewall options: 

1. In the Firewall pane of Security & Privacy preferences, click Firewall Options. 

2. Select the firewall type or types you want: 

  

• Block all incoming connections—Select this checkbox to allow incoming connections for basic Internet 
functions only. You can still check email and browse the web, but this mode prevents Sharing services in the 
Sharing pane of System Preferences from receiving incoming connections. To use Sharing services, deselect 
this option. 

• Automatically allow built-in software to receive incoming connections—Select this checkbox to allow built-
in apps to be automatically added to the allowed-apps list. By doing this, you won't be prompted to 
authorize them. For example, because Calendar is built by Apple, it’s automatically allowed to receive 
incoming connections through the firewall. 

• Automatically allow signed software to receive incoming connections—Select this checkbox to allow apps 
signed by a valid certificate authority to be automatically added to the allowed-apps list. By doing this, you 
won't be prompted to authorize them. For example, because iTunes is signed by Apple, it’s automatically 
allowed to receive incoming connections through the firewall. 

• Enable stealth mode—Select this checkbox to prevent unauthorized or unexpected probes from receiving a 
response from your Mac. Your Mac will still answer requests for authorized apps. But other requests, such as 
network pings from other computers trying to discover your Mac, won’t get a response. 

3. Click OK when you’re done making changes to the Firewall options. 

4. Click the lock to prevent further changes. 

You’ve configured the built-in Firewall service and increased incoming network connections security. 

Connecting to a VPN service 

With VPN access, you can use network services while you’re offsite and prevent access by unauthorized individuals. 
Through a built-in VPN client, macOS supports the following standards-based protocols to provide encrypted VPN 
connections: 

• Layer 2 Tunneling Protocol over IPSec (L2TP/IPSec) 

• Internet Key Exchange (IKEv2) over Internet Protocol Security (IPSec) (IKEv2/IPSec) 

• Cisco IPSec 
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• SSL VPN clients on the App Store, such as those from AirWatch, Aruba, Check Point, Cisco, F5 Networks, 
MobileIron, NetMotion, Open VPN, Palo Alto Networks, Pulse Secure, and SonicWall 

To connect to a VPN service: 

1. Get the following information from your network administrator: 

• VPN server address 

• VPN type 

• VPN account name 

• User authentication information 

2. Open System Preferences. 

3. Click Network. 

4. Click Add (+) at the bottom of the network connection services list. 

5. Choose VPN from the Interface pop-up menu. 

6. Choose the kind of VPN connection you want to set up from the VPN Type pop-up menu. 

7. Give the VPN service a name. 

8. Click Create. 

  

9. Enter the server address and the account name for the VPN connection. 
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10. Click Authentication Settings and select your Authentication Settings. 

  

11. Click OK. 

12. Click Apply. 

13. Select the server you want to connect to. 

14. Click connect. 

15. Select “Show VPN status in menu bar.” 

This enables you to use the VPN status button to connect to the network and switch between VPN services. 

You can now connect remotely to your network and maintain security. 

Summary 
In this section, you learned how to secure a Mac at the user data, system, and network levels. You should now be 
able to perform these actions: 

• Improve user account security for your Mac by using strong passwords. 

• Use two-factor authentication. 

• Set a firmware password for low-level system protection. 

• Lock a Mac screen. 

• Disable automatic login. 

• Configure FileVault to protect your startup disk files. 

• Use Gatekeeper to download safe apps. 

• Configure the macOS firewall to restrict incoming network access to services and data by other computers. 

• Configure your Mac to securely access a remote network using the VPN service. 
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Printing
With macOS, you can quickly connect to and share a local printer. You can also use remote printers on a network. 
Mac computers can share printing resources with Windows computers, so both types of computers can access 
common printers. 

In this section, you’ll learn how to perform these tasks: 

• Configure your Mac to print to a locally connected printer. 

• Share a printer with network users on other platforms. 

• Set up your Mac to connect to network printers using common printer protocols. 

• Optimize network printers. 

Connecting to a local printer 
macOS comes with software for many third-party printers, so you can connect a USB printer and the print queue is 
automatically created. If this doesn’t happen, follow these instructions: 

To print to a Universal Serial Bus (USB) printer: 

1. Ensure that the printer is connected to your Mac. 

2. Add the printer to your list of available printers. 

To add a USB printer to your Printers list: 

1. Follow the instructions that came with the printer to set it up and connect it to your Mac. 

2. In the App Store, check for available updates. 

This step ensures that macOS has the latest information about the printer software that it can download from 
Apple. macOS updates its list of available printer software and downloads the software as needed when you 
add printers. 

3. Open a document to print and choose File > Print. 

4. Open the Printer pop-up menu and choose your printer. 

5. If you don’t see your printer, contact the printer manufacturer for more information. 
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Setting up a wireless printer 
If your printer has built-in Bluetooth or Wi-Fi, you can print to it wirelessly. 

To set up a printer with built-in Wi-Fi: 

1. Follow the directions that came with the printer to set it up and connect it to your Wi-Fi network. 

2. In the App Store, check for available updates. 

This step ensures that macOS has the latest information about the printer software that it can download from 
Apple. macOS updates its list of available printer software and downloads the software as needed when you 
add printers. 

3. Open a document to print and choose File > Print. 

4. Open the Printer pop-up menu and choose your printer in the Nearby Printers section of the menu. 

To set up a Bluetooth printer: 

1. Follow the instructions that came with the printer to set it up. 

2. In the App Store, check for available updates. 

This step ensures that macOS has the latest information about the printer software that it can download from 
Apple. macOS updates its list of available printer software and downloads the software as needed when you 
add printers. 

3. Open a document to print and choose File > Print. 

4. Open the Printer pop-up menu and choose Add Printer. 

5. Select your Bluetooth printer, then click Add. 

If your printer isn’t in the list, Bluetooth may not be enabled on your Mac. 

6. Turn the printer on in Bluetooth preferences. 

Sharing your printer 
You can share a printer that’s connected to your Mac with another Mac or with a UNIX computer. The other 
computers must be on the same local network as your Mac. You can’t share a printer that’s connected to your Mac 
with Windows computers. Printer sharing is for printers attached directly to your Mac. You don’t need to share 
network printers, because they’re already shared on the network. 

To share your printer: 

1. Open System Preferences.  

2. Click Sharing. 

3. Select the Printer Sharing checkbox, if it’s not already selected. 

4. Under Printers, select the printer you want to share. 
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When you share a printer, users on your network (Everyone) can use it by default. If you want to restrict access 
to specific people, continue with step 5. 

5. Click Add (+) at the bottom of the Users list. Then choose one of the following options: 

• Select a user from Users & Groups, which includes everyone who has a user account on your Mac. 

• Select a user from Network Users or Network Groups, which includes everyone on your network. 

• Select a person from your contacts, create a password for the person, and then click Create Account. 

• Click New Person. Enter a name and password for the person, click Create Account, and select the person 
from Users & Groups. 

When you add people to the Users list, access to the shared printer is reset to No Access for Everyone. 
“Everyone” is users on your network. If you want Everyone to have access again, click the triangles and choose 
Can Print. 

To remove a user from the list, select the user’s name and click Remove (–). You can’t remove Everyone. 

Setting up a printer shared by a Mac and a PC via SMB or CIFS 
You can print to a printer that’s connected to a Windows computer if it supports SMB or CIFS. The printer’s owner 
should set up the printer that will be shared. The owner must use only the following characters in the printer and 
computer names: 

To print to a printer shared by a Windows computer: 

To add an SMB or CIFS printer to your Printers list, obtain the printer’s workgroup name. You may also need to 
know the user name and password for the printer. 

1. Open a document to print and choose File > Print. 

2. Choose Add Printer from the Printer pop-up menu, then click Windows. 

A network browser appears, listing the Windows workgroups on your network. 

3. Select the printer from the network browser. 

To locate the printer in the browser, click the workgroup, then click the print server (the computer that’s 
sharing the printer). If prompted, enter the user name and password for the printer. 

4. Choose the printer software appropriate for the shared printer from the User pop-up menu. 

Be sure to choose the correct printer model for the printer you’re adding. For more information, read the 
documentation that came with the printer. If you have an HP Printer Command Language (PCL)–compatible 
printer that’s not listed, choose the most similar model. 

5. Click Add. 

If you can’t add the Windows printer, your printer software may not support printing via SMB or CIFS. If this is 
the case, update the printer software on your Mac, or ask your network administrator for help. 
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Setting up an IP printer 
If a network printer you want isn’t in the Printers list, you can add it as an IP printer. An IP printer must support one 
of these printing protocols: 

• Internet Printing Protocol (IPP) 

• Line Printer Daemon (LPD) 

• HP Jetdirect (Socket) 

To add and print from an IP printer: 

1. Obtain the information listed below. If you need help, contact the person who manages the printer or server. 

• The network printer IP address or hostname 

• The printing protocol being used 

• The network printer model number or printer software name 

• The printer queue name, if the printer uses a special queue 

2. On your Mac, choose Apple menu > Software Update. 

This step ensures that macOS has the latest information about the printer software it can download from 
Apple. macOS updates its list of available printer software and downloads the software as needed when you 
add printers. 

3. Make sure that the printer is connected to your network and ready to print. 

4. Open a document to print and choose File > Print. 

5. Choose Add Printer from the Printer pop-up menu. 

6. Click IP. 

7. Enter the printer information. Use the following table as a guide: 

Option Description

Address Enter the printer IP address (for example, 192.168.20.11) or hostname (for example, 
printer.example.com).

Protocol From this pop-up menu, choose a printing protocol that your printer supports. 

Internet Printing Protocol (IPP)—Modern printers and printer servers use this protocol. 

Line Printer Daemon (LPD)—Older printers and printer servers may use this protocol. 

HP Jetdirect—Socket: HP and other printer manufacturers use this protocol.

Queue If your printer requires it, enter the queue name for your printer. If you don’t know the 
queue name, try leaving it blank, or see your network administrator.

Name Enter a descriptive name for the printer (for example, “Color Laser Printer”) so you can 
identify it in the Printer pop-up menu.
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Specifying printer features 
If your printer options weren’t detected when you added it to your Printers list, you can specify them. If you 
modified its features after adding a printer to your Printers list, you may need to update Options. For example, the 
Print dialog may not display options for two-sided printing because the printer’s duplex unit wasn’t detected. Or 
you may have moved an extra paper tray from one printer to another, and your printer didn’t detect the change. 

If your printer uses AirPrint, printer features are determined automatically, and you can’t turn them on or off. 

To specify your printer features: 

1. Open System Preferences. 

2. Click Printers & Scanners. 

3. Select your printer in the list at the left. 

4. Click Options & Supplies, then click Options. 

5. Select the options you want to see when you print. 

Printing from a network printer 
In addition to connecting to local printers, macOS can easily connect to network printers. You can connect to 
printers on your local network that use Bonjour, IP, and Open Directory, and you can connect to shared printers. 

Note: If you connect a printer that has a scanner to a local network, other computers on the network can see 
what’s on the scanner bed. If you scan documents with sensitive information, connect the scanner to your Mac USB 
port. 

To print from a network printer: 

1. Set up the printer using the instructions that came with it. 

2. Connect the printer to the network. 

3. In the App Store, check for available updates. 

This step ensures that macOS has the latest information about the printer software that it can download from 
Apple. macOS updates its list of available printer software and downloads the software as needed when you 
add printers. 

4. Open a document to print and choose File > Print. 

Location Enter the printer location (for example, “outside my office”) so you can identify it in the 
Printer pop-up menu.

Use If the pop-up menu doesn’t show the software for your printer, choose Select Printer 
Software. Then select your printer in the Printer Software list. If that list doesn’t include your 
printer, install the printer software (printer driver) from the printer manufacturer. You can 
also choose generic printer software from the pop-up menu.

Option Description

Mac Integration Basics 10.12 - Guide   40
© 2017 Apple Inc. All rights reserved. Apple and the Apple logo are trademarks of Apple Inc., registered in the U.S. and other countries.



5. Open the Printer pop-up menu and choose your printer in the Nearby Printers section of the menu. 

6. If you don’t see your printer, choose Add Printer from the Printer pop-up menu. 

A dialog appears listing any Bonjour, IP, Open Directory, and shared printers on your local network. It may take 
a minute or two for your printer to appear. 

7. Select your printer when it appears in the list, then click Add. 

macOS automatically uses AirPrint if your printer supports it, or it selects printer software (also called a printer 
driver) and downloads it from Apple, if necessary. If you don’t see your printer in the list, refer to the following 
sections: 

• “Setting up a printer shared by a Windows computer via SMB or CIFS” 

• “Setting up an IP printer” 

A Mac can usually detect if a printer has special accessories installed. These special accessories may include: 

• Additional paper trays 

• Extra memory 

• A duplex unit 

If it can’t detect them, a dialog appears and you can specify the accessories. Make sure the settings in the 
dialog reflect your printer’s installed accessories so you can take advantage of them. 

Summary 
In this section, you learned different ways to use a Mac with local and network printers. You should now be able to 
perform these tasks: 

• Configure a Mac to print to a USB printer. 

• Configure a Mac to print to a network or Windows printer. 

• Share a local printer with network users. 
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Instant Messaging
Organizations use instant messaging to keep local and remote team members connected. Messages is the built-in 
chat client included with macOS. You can use it to send messages using iMessage or third-party messaging 
services, including the following: 

• Jabber 

• Google Talk 

• Yahoo! 

• AOL Instant Messager (AIM) 

You can also use Messages to send files to people on your local network or across the Internet. And you can set up 
audio and video chats to keep in touch with colleagues around the world. Messages supports the high-quality 
H.264/Advanced Video Coding (H.264/AVC) codec for video chats. 

In this section, you'll learn how to configure a Mac to work with instant messaging services. 

iMessage 
iMessage is a secure instant messaging service on Apple devices. With iMessage you can send texts, photos, or 
videos to Apple devices over Wi-Fi or cellular-data networks. The messages appear in blue text bubbles. You don’t 
have to wait for your colleagues to go online to send a message. When you send it, they get it on all their Apple 
devices that use the same Apple ID and have iMessage enabled. When you view an iMessage conversation, you see 
all messages sent from Apple devices, so you can communicate with your contacts wherever you are. 

Instead of using buddy names, you can use phone numbers or email addresses to send messages. From Contacts, 
you can enter a name and select the phone number or email address you want to send the message to. 

You need an Apple ID to use iMessage with the Messages app. If you have an iTunes or iCloud account, you have 
an Apple ID. If you don’t have an Apple ID, you can create one in Messages. 

Jabber 
Messages supports Jabber, the Extensible Messaging and Presence Protocol (XMPP). Jabber enables Messages to 
communicate directly with popular messaging services. 

You need a Jabber account to send messages to people who use Jabber. You can get a Jabber account from a 
Jabber service provider, or your organization may have a Jabber server you can use. For example, macOS Server 
comes with a Messages server, which is based on Jabber technology. After you set up a Jabber account, you can do 
the following with other Jabber users: 

• Use Messages for conversations 

• Have audio and video chats 

• Use screen sharing, if the others users have the hardware and software to support it 

Network providers who’ve agreed on operation standards can create a federated network. If your Jabber account 
provider uses a federated network, you can send messages to other Jabber users whose providers also use 
federated networks. You can add those Jabber users to the buddy list for your Jabber account. For example, 
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Google Talk is a Jabber-based service on a federated network. You can chat with Google Talk subscribers if you also 
have Jabber on a federated network. You can also add them to the buddy list in your Jabber account. 

Configuring Messages 
Before you use Messages, you need to enter information for your service provider accounts. Messages has an 
assistant to guide you through the process. The Messages assistant appears when you first open Messages or add a 
new account in Messages preferences. 

To set up your first Messages account: 

1. The first time you open Messages, an iMessage dialog appears, prompting you to enter your Apple ID. If you 
don’t want to use iMessage, click Not Now to skip this step. 

2. The assistant prompts you to add a Google, Yahoo!, AOL, or other account. Click Cancel to skip this step if you 
don’t want to use an instant messaging account at this time. 

To set up iMessage: 

1. Choose Messages > Preferences and click Accounts. 

2. Select iMessage in the Accounts list. 

3. Enter your Apple ID and password, then click Sign In. 

If you don’t have an Apple ID, click Create Apple ID. Enter the requested information and click Create Apple ID. 

4. In the “You can be reached for messages at” list, enter the email addresses you want to use for iMessage. 

When you enter an email address not associated with your Apple ID, a verification email is sent to that address. 
You must click the Verify Now link in the email before you can receive messages sent to that address. 
Unverified email addresses are marked with “Waiting to Verify.” 

An email address can be associated with only one Apple ID at a time. 

5. Select “Enable this account.” 

You can send unlimited iMessage messages to anyone with an Apple device if the following conditions are met: 

• You have an iPhone device. 

• You can send and receive SMS text messages from your Mac. 

• Text Message Forwarding is set up on your iPhone. 

To set up text messaging on iPhone: 

1. Go to Settings > Messages > Text Message Forwarding. 

Devices that are signed in to Apple ID for iMessage appear. 

2. Toggle the listed Mac to ON. 

iPhone prompts you to enter the code shown on your Mac. This allows iPhone text messages to be sent and 
received on applicable devices. 
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To receive messages sent to email addresses and phone numbers: 

1. Click Add Email. 

2. Enter an email address or phone number. 

3. Select the email addresses and phone numbers you want to use to receive messages. 

If you add a new email address for your Apple ID, you’ll receive a validation email at that address. Follow the 
instructions in the email so you can use the address with Messages. 

If your phone number is associated with your Apple ID, it’s automatically added to the list. For example, if you 
set up your iPhone with your Apple ID, your phone number is associated with your Apple ID. 

Adding accounts 
Before you start, collect information about your existing accounts. 

To access your account information or sign up for Google, Yahoo!, or AOL accounts, visit their websites. If you need 
a Jabber account, contact the Jabber server administrator. 

You can enter the messaging account information in Messages or in the Internet Accounts pane of System 
Preferences. 

To set up additional accounts in Messages: 

1. Choose Messages > Add Account. 

2. Choose a Messages account provider. 

  

3. If you want to add a Jabber account, choose “Other messages account.” 

4. Click Continue, and choose Jabber from the Account Type pop-up menu. 

3. Enter your account information: 

• Google—Enter your Google account name and password. 

• Yahoo!—Enter your Yahoo! user name and password. 

• Aol. (AIM)—Enter your AIM user name and password. 

• Jabber—Enter your Jabber account name and password. If your Jabber service provider gave you specific 
server information, enter it under Server Options. 

4. Click Create. 

Messages should connect to the Messages service. You may see contacts with AIM or Messages accounts from 
Contacts listed in your Buddies list. If you don’t have any contacts with AIM or Messages accounts, your 
Buddies list will be empty. 
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Chatting on a local network with Bonjour 
Bonjour is Apple's implementation of zero-configuration networking (zeroconf ). zeroconf is a group of 
technologies that includes service discovery, address assignment, and hostname resolution. Bonjour locates 
devices such as printers, other computers, and the services that those devices offer. It does this on a local network 
using multicast Domain Name System (mDNS) service records. 

You can use Bonjour to send messages to other Messages users on your local network without using a messaging 
account or server. 

If you connect to the Internet using Point-to-Point Protocol (PPP) or Point-to-Point Protocol over Ethernet (PPPoE), 
you won’t see other Bonjour users. If you connect via a shared network segment, which is common with cable 
modems, you may see other Messages users. 

If your Mac is behind a firewall, you may not be able to receive messages from other Bonjour users. To use Bonjour, 
you need to change your firewall settings to allow activity on port 5298. 

If you have trouble using Bonjour, contact a network administrator to adjust your network settings. 

To send a message using Bonjour: 

1. Verify the recipient’s identity. 

The names shown in the Bonjour window are based on the person’s card in Contacts. They may not match the 
person’s actual name. Your Bonjour name is shown at the top of your Buddies list. 

2. Enter a recipient’s name in the To field. You can select that person’s Bonjour name by double-clicking it in the 
Bonjour buddy list. 

  

3. If you don’t see the Bonjour buddy list, choose Window > Buddies. 

If all your buddies are shown in one buddy list, Bonjour users are listed under “Bonjour” in the list. 

4. To turn off Bonjour messaging, choose Messages > Preferences, click Accounts, select Bonjour, and deselect 
“Enable Bonjour instant messaging.” 

Summary 
In this section, you learned how to use instant messaging with your Mac so you can collaborate instantly with your 
colleagues. You should now be able to perform these tasks: 

• Configure Messages to send messages to Apple devices and PC users. 

• Configure Messages for use with Jabber, Google Talk, Yahoo!, and AIM. 

• Use Messages to communicate with other Messages users on your local network. 
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Moving and Backing Up Content
When you switch from a PC to a Mac, you can transfer many of your files and use them normally. Common 
Windows file formats—including text and PDF documents, images, audio, and video files—can be opened in 
macOS. 

Protecting your content is important. You should regularly back up your Mac and keep multiple backups of 
important content. Your organization might even have a specific backup policy. And even if it doesn’t, a personal 
backup strategy is best. 

In this section, you'll learn how to move PC content to a Mac. You’ll also learn how to back up content. 

Moving content 
Use Migration Assistant to copy all of your documents, apps, user accounts, and settings to a new Mac from 
another computer. Migration Assistant copies data to a Mac so that you don't have to do it manually. 

If you have a small number of files, you can copy them from the PC onto external or removable storage media. 
Then you can use the media on the Mac. 

You can also send Windows files to your Mac over the Internet using email. 

To move content using Migration Assistant: 

Windows Migration Assistant transfers your contacts, calendars, email accounts, and more from a PC and puts 
these files in the appropriate places on your Mac. 

Before you begin, follow these steps to make sure your migration goes smoothly: 

1. Make sure Windows is up to date. Migration Assistant works with Windows XP and later. 

2. Make sure you know the name and password of an administrator account on your PC. 

3. Connect your Mac and PC to the same network, such as your home Wi-Fi network. You can also connect an 
Ethernet cable between the Ethernet port on your Mac and your PC to create a direct network connection. 

4. Use the check disk (chkdsk) utility on your PC to make sure that your Windows drive has no issues. 

5. Choose Start > Run. 

6. Enter cmd in the Run window and press Return. 

7. Enter chkdsk in the command window and press Return. 

8. If the check disk utility reports that it found problems, enter chkdsk drive: /F and press Return. 

drive (for example, d) is the letter that represents your Windows startup disk. 

9. Press the Y key at the prompt, then restart your PC. Repeat this process until the check disk utility reports no 
issues. 

If you can’t clear a reported disk issue, you might need to have your PC serviced before you can migrate your 
data to your Mac. 

10. On your PC, download the Windows Migration Assistant and install it. 
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11. Quit other open applications in Windows. 

12. Open Windows Migration Assistant on your PC. 

13. To start the process, click Continue in the Migration Assistant window. 

  

13. Start up your Mac. Setup Assistant automatically opens the first time you set up your Mac. If you've already set 
up your Mac, open Migration Assistant from the Utilities folder on your Mac. 

14. On your Mac, follow the onscreen prompts until you get to the migration pane of the assistant. Select the 
option to transfer information "From a Windows PC.” 

  

15. When prompted, enter an administrator name and password. 

16. Click Continue to close any other apps that are open. 

17. Select your PC from the list of available computers in the migration window on your Mac, then wait for the PC 
to show the passcode displayed on the Mac. 
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18. Click Continue on your PC and your Mac after you see the same passcode displayed on both computers. 

  

19. Your Mac scans the drives on your PC to build a list of information to migrate. When the scan is complete, 
select the information you want to migrate to your Mac and click Continue. 

  

You can watch the progress and estimated time remaining on both the Windows PC and your Mac. 

Migration Assistant tells you when migration is complete. Afterward, you can close Migration Assistant on your 
PC and log in to your new user account on your Mac. The first time you log in to a user account that was 
migrated from a PC, you're prompted to set a password. You can use the same password you used on your PC 
or create a new password. See Choosing good passwords in Mac for tips on setting a password. 

Backing up data with Time Machine 
Time Machine backs up your files to an external hard drive so that you can restore them later or see how they 
looked in the past. 

To set up Time Machine: 

1. Get one of these external storage solutions: 

• An external USB, Thunderbolt, or FireWire drive connected to your Mac 

• An AirPort Time Capsule's built-in drive (any model) 

• An external USB drive connected to an AirPort Time Capsule (any model) or AirPort Extreme (802.11ac 
model only) 

• Network volumes connected using Apple File Protocol (AFP) 

2. When you connect an external hard drive directly to your Mac, you might be asked if you want to use the 
drive to back up with Time Machine. Click “Use as Backup Disk.” If you select the option to encrypt, your 
backups will be accessible only to users with the password. 

3. If Time Machine doesn't ask you to, choose a backup disk. 
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4. Open Time Machine preferences from the Time Machine menu   in the menu bar. Or choose Apple menu > 
System Preferences, then click Time Machine. 

5. Click Select Backup Disk. 

  

6. Select an external hard drive, Time Capsule, or other storage solution from the list, then click Use Disk. 

7. After you choose a backup disk, you can click “Add or Remove Backup Disk” to add more backup disks for extra 
security and convenience. 

To back up data using Time Machine: 

After you set up Time Machine, it automatically makes hourly backups for the past 24 hours, daily backups for the 
past month, and weekly backups for all previous months. The oldest backups are deleted when your backup drive 
is full. 

• To back up now instead of waiting for the next automatic backup, choose Back Up Now from the Time Machine 
menu  . 

• To stop automatic backups, turn off Time Machine in Time Machine preferences. You can still back up manually 
by choosing Back Up Now from the Time Machine menu. 

• To cancel a backup in progress, choose Skip This Backup (or Stop Backing Up) from the Time Machine menu. 

• To check backup status, use the Time Machine menu. The icon shows when Time Machine is backing up  , idle 
until the next automatic backup  , or unable to complete the backup   . 

• To exclude items from your backup, open Time Machine preferences from the Time machine menu, click Options, 

then click Add   and select the item to exclude. 

Your first backup may take a long time, depending on how many files you have. You can continue using your Mac 
while a backup is underway. Some Mac computers make backups even when asleep. Time Machine backs up only 
the files that changed since the previous backup, so future backups will be faster. 
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Summary 
In this section, you learned about migrating data from a PC to a Mac. You also learned how to back up your data 
and protect against data loss. You should now be able to perform these tasks: 

• Migrate data from a PC to a Mac. 

• Set up Time Machine. 

• Back up data with Time Machine. 
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Running Windows on a Mac
By now, you know you can easily integrate a Mac into mixed operating-system network environments. In this 
section, you’ll learn about how seamlessly you can work with Windows users after your Mac is integrated. You’ll 
learn about the following: 

• Different ways to install and run Windows 

• How to install Office and how it works well with macOS 

• Which apps have versions available for both macOS and Windows 

• Which Mac apps have built-in support for Windows files 

Running Windows natively or virtually 
An Intel-based Mac uses the same processor as a PC running Windows. This enables a Mac to run Windows natively 
or virtually. You can start up Windows natively on a Mac by using Boot Camp, which is included with macOS. You 
can also run Windows directly in macOS with virtualization apps such as VMware Fusion and Parallels Desktop, 
which create virtual Windows computers on your Mac desktop. 

Installing Windows natively 

Boot Camp helps you install Microsoft Windows on your Mac. After you install Windows and restart your Mac, you 
can easily switch between macOS and Windows. Setup is simple and safe for your Mac files. And, after Windows is 
installed, it runs at native speeds. 

You can use Boot Camp and a Windows installation disk (that you provide) to install Windows on a Mac. Windows 
is installed in its own partition. While you’re using Boot Camp, Windows apps have full access to the following: 

• Multiple processors 

• Multiple cores 

• Accelerated 3D graphics 

• High-speed ports 

• Networking technology such as FireWire, Thunderbolt, Airport, Wi-Fi, USB, and Gigabit Ethernet 

To install Windows natively on your Mac: 

1. Make sure you have everything you need: 

• An Intel-based Mac 

• A Microsoft Windows installation media or International Organization for Standardization (ISO) disk image 
containing a 64-bit version of Microsoft Windows 7 or later 
 
Read more about system requirements to find out whether your Mac supports installing a specific version of 
Windows, or to learn about installing older versions of Windows. If you're installing Windows for the first 
time, use a full installation (not an upgrade) disc or disk image. 

• An Apple keyboard, mouse, or trackpad, or a USB keyboard and mouse 
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• At least 55 GB of free disk space on your startup drive 

• For most Mac models, you also need a blank 16 GB or larger USB flash drive 
 
You don't need a USB flash drive for the Mac computer models listed below. They use the internal drive to 
temporarily store what you need to install Windows. 

• MacBook Pro (Retina, 13-inch, Early 2015) 

• MacBook Pro (Retina, 15-inch, Mid 2015) 

• MacBook Air (13-inch, Early 2015) 

• MacBook (Retina, 12-inch, Early 2015) 

• MacBook (Retina, 12-inch, Early 2016) 

• iMac (Retina 4K, 21.5-inch, Late 2015) 

• iMac (21.5-inch, Late 2015) 

• iMac (Retina 5K, 27-inch, Late 2015) 

• iMac (Retina 5K, 27-inch, Mid 2015) 

• Mac Pro (Late 2013) 

2. Check system requirements. 

Some versions of Windows require a certain processor and more hard drive space and memory (RAM) than 
others. Check the documentation that came with your copy of Windows to find out what you need. Then use 
System Information to see what your Mac currently has. 

2. Get a Windows disk image. 

When you buy Windows, it comes as an ISO disk image file that you download, an installation disc, or a USB 
flash drive. If your copy of Windows came on a DVD, you might need to create a disk image of it to work with 
Boot Camp. If your version of Windows came on a USB flash drive, you can download an ISO disk image from 
Microsoft. 

3. Open Boot Camp Assistant. 

Boot Camp Assistant guides you through installing Windows on your Mac. Open this app from the Utilities 
folder in the Applications folder. Follow the onscreen instructions to automatically repartition your startup disk 
and download related software drivers for Windows. If you're prompted to during installation, connect a blank 
USB flash drive. 

4. Format your Windows partition. 

After you complete the installation with Boot Camp Assistant, your Mac restarts to the Windows installer. When 
you're asked where you want to install Windows, select the BOOTCAMP partition, then click Format. 

5. Install Windows. 

Follow the onscreen prompts to finish your Windows installation. After Windows is installed, you can switch 
between macOS and Windows. 

6. Restart your Mac. 
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Use the Startup Disk preference pane in macOS or the Boot Camp system tray item in Windows to select your 
startup disk, then restart your Mac. 

Installing Windows virtually 

To run macOS and Windows apps simultaneously, install Windows on macOS using VMware Fusion or Parallels 
Desktop for Mac. You’ll also need a full-install Windows installation disk or a Windows ISO disk image of the version 
you use. After you complete this installation, you won’t have to restart your Mac to switch between macOS and 
Windows. 

Using Office 
A native version of Office is available for macOS. The interface is compatible with macOS, so you can create and 
share the following files just as you would on a PC: 

• Word documents 

• PowerPoint presentations 

• Excel spreadsheets 

Even if you don’t have Office installed on your Mac, you can use Quick Look to take a peek at Office documents 
without opening an app. 

Using cross-platform apps 
Software developers offer versions of their apps for Windows and macOS to accommodate the mixed operating 
system environments that many organizations use. Examples of cross-platform productivity apps include: 

• Office 365—Includes Word, Excel, PowerPoint and Messaging 

• Adobe Creative Cloud—Includes Acrobat, Photoshop, Illustrator, InDesign, After Effects, and Premiere Pro 

• Intuit QuickBooks 

• The FileMaker Platform 

Using cross-platform files 
Most popular Mac apps use the same file format as their Windows counterparts. This makes it easy for you to open 
and use files created in Windows on a Mac. Using native Mac apps, you can import and export files created in 
Windows. With these apps, you can view most common file types, including Office documents, PDFs, images, text 
files, MP3s, videos, and ZIP files. For a more complete list of common files types and extensions, refer to Windows 
files on a Mac. Here’s a list of popular Mac apps with support for Windows files: 

• Pages—You can import and export Microsoft Word and most other Windows text formats. 

• Numbers—You can import and export Excel and Open Financial Exchange (OFX) files from Quicken, comma-
separated-values files, and tab-delimited files. 

• Keynote—You can import and export PowerPoint presentations. 

• Any QuickTime-compatible app—You can import .avi video and .wav audio files. 
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Summary 
In this section, you learned about macOS cross-platform compatibility. This compatibility enables you to work 
seamlessly with Windows users. You should now be able to perform the following tasks: 

• Configure a Mac to run Windows natively with Boot Camp. 

• List third-party virtualization options for running Windows. 

• Describe the benefits of using Office on a Mac. 

• List apps that are available on both Windows and macOS. 

• List native Mac apps that support Windows file formats. 
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Additional Resources

Books 
The Apple Training Series book macOS Support Essentials 10.12: Supporting and Troubleshooting macOS Sierra is a key 
part of Apple’s official curriculum. This book enables you to independently prepare for the Apple Certified Support 
Professional (ACSP) certification exam. It guides you, step by step, through real-world tasks. The book is also an 
excellent reference for performing specific tasks and learning about specific technologies. It’s published by 
Peachpit Press. 

Courses 
Mac Basics on the Apple Support site provides online training materials for new macOS users. 

Sierra 101—macOS Support Essentials 10.12 provides an in-depth exploration of troubleshooting on macOS. It also 
covers the breadth of functionality of macOS. Apple Certified Trainers teach this—and other courses—through 
LearnQuest and Apple Authorized Training Centers for Education (AATCEs). You use the macOS Support Essentials 
10.12: Supporting and Troubleshooting macOS Sierra book extensively in this course. 

Certifications 
macOS Certifications certify IT professionals who support macOS users. 

Apple Certified Associate - Mac Integration 10.12—This certification verifies that you understand the different ways 
to integrate a Mac within a Windows or other standards-based network. It also covers the seamless way that 
macOS users can work with Windows apps and files. 

Apple Certified Support Professional (ACSP) 10.12—This certification validates basic macOS support and 
troubleshooting skills. 

For more information about available Apple Certifications, visit Apple Training and Certification. 

Support 
Apple provides online support where you can access technical articles, download manuals, and join discussion 
forums. 
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